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PC Connection : Firmware update and IRS serial or USB control

Overview :

The SUPERVISOR program is used for maintenance purpose.
The latest version of the SUPERVISOR program can be downloaded from our WebSite.

When connected it will be possible to:
o control the regulation for test purpose
o0 upload/download the firmware
0 setthe IRS main parameters

Hardware connection:

ajewal 6 ad

DB 9 female

Connector 1 Connector 2 Function

2 3 Rx #— Tx

3 2 Tx —» Rx

5 5 Signal ground

To use the RS232 connection, one needs a null-modem cable with a DB9 female connector to link the PC
to the IRS.

On the newest version of IRS system, the Rs232 connection is completed with an USB interface. In this case

it is possible to use any adequate USB cable.
For USB connection the USB cable with special filters is recommended (see appendix). If connection is

successfully established the USB LED will light on steadily.

RS232 DB€ connector USB LED USB connector

When connecting the computer to the IRS module through the serial link, you have to pay attention to have both
devices wired to the same ground to avoid any electrical discharge that can damage both devices.
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Installing the software:

The SUPERVISOR is available from our Website.

Once unzipped, run the setup.exe program to install it onto you Windows system. Before using USB
connection the USB port driver must be installed. USB port driver is provided along with the SUPERVISOR
distributive.

Configuring the software:

There is only one thing to configure. You have to choose in the option > Com Port menu the COM Port
which connects the PC to the IRS. For USB connection you must select virtual Com Port COM3.
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Using the software:

The SUPERVISOR interface looks like the picture below:

=I5
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8 LTI N I W TN 7 | NEET] | | (| 7 | OO | | ALARMS
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[Hard Info: 101, MWV 700, MMIA - D, 1D : PWRT206012010100001 ]!
[SDL - 1510 50L sdeard 25Mhz Fgﬁr Fiu: v21 1E,gghur w101

The connection status is summarized on the lower right part of the window.
Once started the program tries to connect to the IRS... It takes a few seconds to connect.

.The program has two modes (mode menu):
- The monitor mode
- The control mode

The monitor mode is used to monitor the settings of the IRS. This function can be used once or
repeatedly (pooling)...

In this mode, the program returns the power applied to each lamp (PWE), the resistance measured
for each lamp (RM), the service voltage set for each lamp (SRVV), the nominal power set for each
lamp (MAXP), the status of the oven (On/off), the measured supply voltage (SV).

The control mode allows to control the regulation by sending the different settings to the IRS (SRVV,
MAXP, PW, run on/off).

Information sent with the Supervisor: .

%l{?"{l |Fw:~.-'2'l.18 | Hus : w101
\
Connection OK l Regulation Mode I Firmware l Hardware I
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. . . [E] ardware Setting ol X!
Beside standard functions, the program is Py ——— = CrenCoi e
also used to configure the IRS or to get Hidhenv o), (T e [aiais

N . Mainklat ois: 700 W (700- 300') () Single Cycla % Single Cycle
factory information (menu tools=> hardware Varka g [T, Apnana)  Praseinge
information) . B F/FT 20801 20701 00001 IS s sk e I Alaps use Fnom

—'| Broken Lamp: Bioken Lamp -
Read only: s s o St 0 *
_ Hardware Version : i - Curtent— P*Nﬁ - Current— Tick : == Tick : ﬁ

. . L — - | | | -0 Burst Firing - Burst Firing :

- MainMaxVolts and MainMaxamps are el gl 2l =g ot [T Theshot: [T

constants used to tune the IRS T | ) O VA | O

. 3 e o 4 P

- ID: Serial number sl ||l =r—=|C =
& o o e o

Han 8 T
Read/Write: ' . . = =5|| |~ ==
- Current configuration for the regulation sl |||l =lr—= =3

mode and of the lamps pre-warming |

(ramps) o (o el )

’ - — - o — - . Ipdate _.I:Ine
[0 _sedl [0 _seél Factory Settlng e |[ e |
(Read Only)
zl
i~ Identification -~ Current Configuration——————— - Mew Configuration—————
Hardware Version: [0l Running Mode : - Running Mode:—| ‘ i
Mainbasvolts: 700 (700 - 300 V) [, Single Cycle & Single Cycle Regulation Mode
Mainhf andmps ; | s A10-204) " Phase Angle
e 1P 20601 2010100001 I Always use Brom T Always usé;lF!nDITI
Broken Lamp : Broken Lamp : \ Sett”‘]g for
~Sioltages——— - Neminal Powsrs ———— Factor: [0 % Fastor:  [200 % suppressing R
~Mew—— ~Curent— ~New—— [~ Current— Tick: [ Tick: |15 -I Measurement

% I l ljl L I L ljl Burst Firing - Burst Firing - \

2l J ljl | L ljl Thieshald: [ 0 Thieshald: [~ 0

3 | 3 | q q

) 18 ) ; N Power ; [0 w Power ; [0 w Detection Sett|ng

e for the Broken

s\ 5| ||| s ¢ |[C= jamp

(0| (C ||| e|r 0|3

o ;

s\ 3| |C ||| & ==

sl 0| (9| & 2|3 .

) ; Warm-up Setting

0 (o ||| ||| || I
0 ) S |
12| 12 0
' d ljl | D |—| Get Current Conf- | Update | Close I
[ © Setal | [0 Setal |

Regulation mode:
Phase angle or Single Cycle can be chosen.

Suppressing R Measurement

When selected, the Resistance of individual lamps are not measured anymore. The Resistance used in the
regulation algorithm is then R = Pnom / Vnom2.

POWER REGULATION IS REPLACED BY SQUARE VOLTAGE REGU LATION
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Detection setting for broken lamps.
These settings are used only for special applications.
These settings should be kept at 200 for factor and 16 for Tick.

Warm-up settings.
Threshold: Duration of the warm-up period for each lamp in 10ms units.
Power: Power applied during warm up in watts.

OPTIMAL SETTINGS: 200 x 10 ms, NomPower of lamps (  for instance 2000 W)

Firmware update:

The latest versions of the firmware are available on our web site in the download section.
From the update window you can select the desired firmware (*.olc file) and transfer it to the IRS. It takes
about 10 sec to transfer the *.olc file to the IRS. The IRS must be rebooted once the installation is finished.

—=S_cgu_4rca_'ri;,:_; 5 i~ Sournce File-
IE\JHS\MEBBBZ\VZDIBEJQ Selest ., | _|E}:¥|F|S\M'C'EBB3ZW‘2_D,'[B{:JE;_ Select .., |
- F'fR24 Firrnwsars Saures File Firrnware i~ PwR24 Firmware ‘Source Fils Firmwars
?’g‘e[ﬁit__ln_;' 2 ?’fgr_sit__m 5 | 2016 Wersion | 2018 Wersion ; | 2018
Size Size [ 21432 Size: [ 7133 Size [ 23
CREC: CRE: | ETTE ChRE: Ba3 CRC. B803
Eancel: Dane Update ! | 1
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Calibration:

To ensure a good process quality the IRS calibration has to be checked.
Voltage calibration:

Use a calibrate Vrms Voltmeter.

Measure the voltage between the two phases inside the IRS.
Enter the value and tick “Calibrate voltage”.

Vrms read and Vrms expected must be equal.

El Calibration Interface

Vims read by IRS # PR 370
Vg Expected - 400
Enter the value -
Lalbrate Woltage

here.

Procedure : Turn main power on. Usge the Calibrate Yoltage button to
calibrate the voltage according to the supplied voltage [Vims expected).

Cripdbdts : 700

| Offset | 0 mi Expected | 0 md
| Inst. : | 0 mb Expected | 0 mb

Thearitical walue of Offzet when no load | ]
(1 OffFzet + 1 Inst)

| Set Offzet (Mo current in Sensar] I

Lalibrate Current |

Step 1 Tun power on, Oven O, Tune the Offset to get | Ingt =0 +- 10
mé. [| Inzt =1 Read - | Offzet]

Step 2 Tun power and 240C off. Replace black and green wireg on
CH1 by a 10k resistor. Current should be zet at 3000 ma. If uging 5 k.,
current will be B000 mé&. Turn 24 DC and then Power on. Do cument

calibration
Cloze
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Current calibration:

El Calibration Interface

Yme read by IRS A PWER
Wims Expected : [ s
Lalibrate Yoltags i

Frocedure ; Turnmain power on. Use the Calibrate Yoltage button to
calibrate the voltage according bo the supplied voltage [Vims expected).

CrttdMY ; 744

| Oiffset: | 0 omd Espected | 0
llnst.: [ 2996 m& Evpeced [ 2000 ma

heoritical value of Offset when no load 2995
1 Oftzet +1 Inst]

Set Offset Mo cument in Sensar)

LCalibrate Current |

Step 1 Tum power on. Oven Off. Tune the Offzet bo get | Inst =0+ 10
mé [l Ihat =1 Read - | Offzet]

Step 2 : Tumn power and 240C off. Replace black and green wires on
CH1 by a 10k resiztor. Current should be set at 3000 md. If using 5 k.
current will be 8000 ma. Turn 24 DC and then Power on. Do current
calibration

LCloze

MCU Board

MEASUR. TRANS. =15V +15V IN

on (B[RS

T
| —

R=10K
Q.1%

) &
Arms

1°' AC power ON set the |
Offset Expected the way is
to obtain | inst = 0

2" Plug the Current
calibrator and enter the
value 300C in | Inst
expected then set
Calibrate Current
With the current calibrator
WO12 1 you have 1%
precision

Instead of using the current calibrator you can
use a calibrate Arms amperemeter and
measure the current through the resistance.
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Last Sector (Power supply) Default

E-mail: purchase@olicorp.ch
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Just click “Get Last Graph from PWR” to see the AC power default. The wave is shown positive to simplify

visualisation.

| Last Sector Default

700
B65

Save | Open |

=
- Detault i_hfan-nq!_iph; -
MNone

o0
55

Last Yims
read (V]

Last Periods
tead (micro §]

55&
B
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Belst

o
0

T

] o e e e A
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Caphure new Graph now |
142 k. count ; gj

S Braph fiom PwH |

Example:

404*SQR(2) = 569V
e

700
665
630
595
560
55
430
455
420
35
350
il
280
205
210 |-

175

140
105

70
A5

You can save
the graph

I S G S 4 6 0

0 72 24 36 48 B0 72 B4 96 108 120 132 144 156 168 180 192 204 216 228 240

1000000/(2*10000uS) = 50Hz

- Default infan

No default

Lastms st Periods
read [v] d [micro 5]
40398019752 | 1R004
403856410 (10002
40385641012 (10008
40398019757 | 9997
40385641012 (10004
40385641012 | 9998
40373258476 10002
40336083060 | 9997

Capture new Graph naw

1/2 &l count : [ @ j

AR Ermnica
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DATALOG Module

The new high end IRS systems available since January 2010 are equipped with a Datalog module that can
be used to record all the events occurring in the IRS and power supply.

This system gives access to better maintenance capabilities.

Setting up SD-card:

Following SD cards are approved for Datalog: Transcend, Kingston with memory volume up to 2GB.
SD cards from other manufacturers were not tested, and reliability can not be guaranteed.

SD Card INSERTION.

1. Insert MicroSD card into adaptor, then insert the adaptor into the PC or NoteBook card reader.

e e nanes  Start the SUPERVISOR program on your PC. Select Tools -> Log in menu
Fle Mode | Tools Options Heln  toolbar.

QI .l [ Fjrmwafrs B.'ackup

Firmware Lpdate:
Hardware Settings

Calibration Wizard gs
i Last Sector DeFaul
Seffings— —— " E—
Set Ignore Profibus. -Ijed—

R

Before use the SD card must be prepared. To do so, choose in the tool bar Tools -> Prepare SD Card:

M[=Es
FIIE Tools  Yiew HB‘D
Statistics Commen e
ko Session Frames: 0 tie] vRws [ Perod |
800 — Date: .
Murr Events in Frame: 0
Fao -
40— Power Applid Aesistance Lamps
L 1 L}
4S80 2 [
40 |- 3 i
4 0 =1
sl 5 B
6 B
w0 7 L)
a ] ]
01— 3 ] B
100 ] B
= 10 0 [ ]
g b= L T u]
[T — ko
o e T @
Oven OFF F @
Overload @
L A e F e
Dverheat F @
Broken Lamps ¥ @
SectDef Freq Change B
SectDef dlt Missing ¥
SectDefOutof Bond B
Zlq H 51| | SectDef Power < 100
- — SectDefVoltage +#10 ¢
ﬁta_uhw_..a\ggs Dot |  Seaichevent -{-lNEXT hd Séc‘tﬂewn!lgﬁﬁ N @
Wmth';g@nh_'il'““ 't Search .'{-lLAST x| SelsctAl & DeselectAll
T
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Prepare 5D Card

Letter | Dlescription

[=h)
o
EM
F:
G
H:A

Fixed

Fixed
CD-ROM
Fixed

Fixed
Removable

Feady

Cancel |

In the popup window select the line “Removable”
and press OK. In reply to the question you must
confirm “Do you really want to format the disk *:\"

Press OK.

warning x|

1 } Do you really wank ko Format the disk H:y
L

OTMEHA |

SD card preparation process may take up to 2 minutes (depending on the memory size) and may end:

Prepare SD Card ]

Successfully

Letter | Deseription

[
15
EX\
F
G

Fixed
Fined
CD-ROM
Fixed
Fixed

T Femovable

———
Dizgk has been prepared

Lirs I

x|

Not successfully

Prepare SD Card J x|

Latter | Description |
i\ Fixed
o Fixed
E CO-ROM
F \ Fixed
Fixed

o —TT

Disk H:% not farmatted

Cancel |

If the preparation was not successful, please replace the card and start again with another SD card.

You need to test SD card after preparation on MCU board

Datalog.

To do so you need to insert SD card in card holder, located on

MCU board.

- SD Card can be inserted and removed without disconnecting compcard :
the 24V supply. LED :

- SD card can be inserted or removed ONLY when the “SD
Card communication LED” is flashing.

If the SD card is successfully inserted the “SD Card
communication LED” must light on without flashing.

If the LED is flashing instead, then the SD card is damaged and

must be replaced.

JAN

When inserting the SD Card in the card holder located on MCU board, you have to pay attention to have
both devices wired to the same ground to avoid any electrical discharge that can damage both devices.

EURASIA
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Safety :

The installation, configuration, commissioning and maintenance of the IRS products must only be carried
out by personnel qualified and trained to work with low voltage electrical equipment in an industrial
environment.

The front door should not be opened except by competent technicians when connecting or disconnecting
the device. Electrical isolation must be ensured between the equipment and the power supply.

In both off and on modes, the IRS regulator does  n't ensure isolation from the power supply. One
should pay attention to the fact that electrical sh ock may occure when touching the lamps or the
cables coming from the IRS.

It is thus recommended to turn off the power supply (400 V) within 2 sec following the end of
regulation.

> B P

How to set Real Time Clock (RTC):

B OLICORP - IRS PWR SUPERYISOR - ¥EH

File Mode | Tools Gptions Help

To set up the Real Time Clock (RTC) it is necessary to set up USB

e T connection. You need a USB cable with connector on the IRS side and
ﬂﬁl e the SUPERVISOR program. We advise to use USB cable with special
Hardware Settings filters. If the USB connection is established successfully, the USB LED
Calibration Wizard gs will light on steadily.
| Next you need to select SetTime from the menu. At his moment your
[ s ey | PC time will be set for the RTC Datalog, and the window with the
| e S current RTC value will open (see pic. below)
i il L 0]
> I_1 SetTime m
Log
3 | ooy 0 < SetTme )
2010-07:07 16:43.43 |
R EURASIA The way to your commercial and
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Viewing log file:

Before viewing the LOG file insert SD card in the adaptor and then in the card PC reader or Notebook.

In the menu open File -> Open.

In the opened window select file Events and push button Open.
The Events window is used to view LOG file:

Selected Wave (on

View Parameters of

View Parameters) I Type of Event I Wave Form I Frame
[ Events k_ _ F =lolx|
o el
Ed] BT J
Soks ion: 43018 Date frame: 2010.06. {15:15:13,3077 Sesdon, 43110 Fuames 7

200

Frame stop time

Event’s time

Frame start time

Date: 2010-06-28 1616133077
Evenls in Frame: 1 1
Hwt 101 S 2118 Mode: (0
Burst Fiing Threshold 0
BustFiing Power 0

0 370,00
370,00

10000
10001
oo0g

2 3704
3 a0aT
4 34
5 3.4
6 370,14
7 amar
8 370,37

Power Applied Resistance Lamps
L]

=|=|a]
=

1037037

lmegéxs
13 370,14
I ©am.14

370,00

<
v
b=

[ View|selected Frame ]

-

=]
i

@
=]

370,00
370,00
36190
339,23
348,12
350,00
362,50
354,40
35967
366,66
3.4

=
=)

EEEE

=)
E||:a

m

Oven OM
Oven OFF
Overload

Selected Frame

= | | Cutout
verheat

B “en Lamps
Sect “Freg Change
SectDet, * Missing

368,10
359.99
360,44
35996
360,14

v TP

Etautt et hissing

Type of Events

360.56
360,83
361,11

1334

213

1369 157953

SectDef Ow "Sond
SectDef Power 10

Ewent

AR
1SN SSSSSH

3138

™ Markd S

lK] <] » >I|EySlap |

»Q{gewu\tage -
Sl inlage w2

of Wave Form

Time of Events Sy Sessn s >.‘>l 5@ k2 T ,,}_“:flecl; @ 000 0
Ready y 4 SRNE NN N - T
Line and Width Last and Next Event | Search Events tool I Zoom

Last and Next Session

“View all Events ” window is used to search for specific events. By pushing Last and
Next Events you will move following or previous event consequently.

Global search within the LOG file is done by pushing the buttons Last or Next Session.

Search by the type of the event is available through choosing specific type of the event in

the Search Events tool window. Once

move you forward or back within the selected type of the event.

To set the limitations on the search, one may set up markers (Markl and Mark2

Owven OM
Owen OFF
Owerload
Cukout
Owverheat

Broken Lamps
SO Wolkage +/410
SO Yoltage +/- 2
SO Power < 100
S0 Freq Change
SO Ak Mizsing
SO Out of Bond

event type selected, buttons next and last will

consequently) for the boundaries of the search area. This option also allows setting up time interval for the

search.

To view selected Frame in details use “View Selected Frame”.

To increase/ decrease the number of

sectors depicted in the window, one must use Zoom button. One can also select specific Wave and view its
parameters in the window: “Veiw Parameters of Frame”
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Examples of various Events:

=10 x
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SeciDef At Missing  f2 @ [|f3e 7600 10010
14BRERIERS | 1 199 BT eciC 34 7816 807
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o - - SeciDet \Mt@a 10 7 @& ||z 7o 10010
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Ready i
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“hits : Frames: 7 Ik T
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i ‘ b ERET AT
# 4 18075 9906
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9 1ee7s 10004
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